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What is this about?
The idea of MYSTY is to encourage teachers and pupils to use digital technology and storytelling as fun educational tools, with the aim to increase everyone’s awareness of cultural diversity within society.
Cultural diversity is the existence of a variety of cultural or ethnic groups within a society
Some of your friends and peers at school may not share the same traditions as you, and this is your opportunity to talk about your own personal experiences, responding specifically to the themes Family, Food and Festivals. 
By taking part in this project, you will learn more about your peers and help create a more positive environment by acknowledging and respecting people’s cultural differences! You will work on your own and in teams to create amazing stories using professional editing software, just like they do in the movies!
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[image: ]What other pupils say…
[image: ][image: C:\Users\jama\AppData\Local\Microsoft\Windows\INetCache\Content.Word\avatar-2191918_640.png]Here’s what I loved about this very project: not only thinking about it, or giving it small thoughts all the time, speaking loud and clearly while recording and then editing my story, but also the memories that came to my mind while producing it.
Matteo
I personally really liked this project, and the fact that I like telling stories is not the only reason for that. Coming up with a good story idea was like exploring my memories and going through all these awesome moments I have spent with my family. This was probably the part of the project that took up the most time for me. However, when I finally had some ideas it was quite obvious which of the ideas I would choose to make a good story. I took the story that had most to do with my relation to my family. The story that is very important for me in my life.    Leonie


By focusing on smaller details and by trying to make a small story which actually happened big, there are numerous stages one has to go through. How much time you spend on each of this stages can be chosen individually, some find the brainstorming the most important, others prefer spending time choosing what pictures fit in best or take less time for that and focus on the recording and editing.I think this project was very different to everything we’ve ever done before, but it was a great new experience. I really liked the idea behind this project because I think as the point was to share a personal story you could relate to really well which is definitely interesting. 
Overall I liked this project very much, although it was quite tough and time consuming to produce the stories. Additionally, I think you can also learn quite a lot about your classmates because these are stories you wouldn’t just talk about in school.
Sophie

[image: C:\Users\jama\AppData\Local\Microsoft\Windows\INetCache\Content.Word\avatar-2191932_640.png]For us, it was very interesting and special because we knew that this was a chance to send a message, tell a story or simply share a moment with others, instead of keeping it to ourselves as we’d normally do. We tried even harder than usual because we didn’t want to have to feel embarrassed when others tell us they watched our video but also because we wanted to produce something useful and something we can be proud of.
In our opinion, learning by doing something that we like is underrated, simply because one is more likely to remember but also especially at this age boys and girls often start to lose interest in school work. 	Max, Mary, and Moritz

My story
Everybody has a story to tell
Coming up with an idea for a story is probably the most challenging part of this project. Some people have the natural ability to tell a good story, but how are they able to achieve this? The trick is to keep the story simple. Really good stories are often based on a small moment of understanding some little things in life. This is your chance to tell your friends, family and people across the world about something that you want to talk about, and you will create your very own digital short story.
Good stories do not need drama and exaggeration. In this project, we will explore some important moments in our lives and narrate them in the form of digital stories. We will start by brainstorming and collecting ideas, then we will select the most interesting moments and plan how to organize and present them.
A digital story is a fun way of creating narratives using photographs, videos and animation with spoken words.
Our stories will be shared online. Your full identity will not be disclosed, but the fact that your stories will be published might influence your choice of stories and pictures that you want to share. Choose something that you are comfortable with and ask your parents if they agree as well. Make sure to watch the language of the story. Keep in mind that your boss, parents, siblings, friends and others you know may watch your video! Only use your own pictures or pictures free from copyright. Please remember that you must be willing to share your story publicly as it will be put onto the internet. If you have any concerns or questions, please ask your teacher!
So, without further ado, let’s get started!
Brainstorming
As we’ve already said, this will probably be the hardest part of the project. You might have lots of stories to tell or maybe you aren’t quite sure yet.
Use the next two pages to brainstorm and jot down any ideas that come to your mind. Do not filter, you will choose your favorite story later. Talk with others and get inspired by each other!
Have a look through old photographs 
at home or on your phone
[image: C:\Users\jama\AppData\Local\Microsoft\Windows\INetCache\Content.Word\avatar-2191932_640.png]A story circle is an opportunity for smaller groups to gather in a circle and share experiences or stories related to the themes Family, Food or Festival. You may want to bring in a prop or an object that might help you talk about your story. Tip from Max
It took us a lot of time to think of a story that was right for this specific project. What helped a lot in this case was exchanging ideas and thoughts with the others. The brainstorming in groups was a great possibility to come up with an idea.



[image: ][image: ]Special family moments
Special objects in my life

[image: ][image: ]Adventures and accomplishments
Special people I have met

[image: ][image: ]Special places in my life
Celebrations in my life

[image: ][image: ]Mental snapshots and images in my head
How I discovered that…
Homework: Find memory props
Look through your photo albums and look around your home to find any interesting pictures or objects that might trigger a good story. Bring them to class (or bring snapshots of the objects).



Finding your story
[image: C:\Users\jama\AppData\Local\Microsoft\Windows\INetCache\Content.Word\avatar-2191931_1280.png]Look at your ideas and find two or three possible stories that you might use in this project. Take two or three index cards or fold an A4 paper into A5 and write down your stories as if you were telling them to a friend. Write quickly, without too much filtering. Remember, these are rough first drafts. For each of your stories fill the front and back of one index card.Tip from Leonie, Anja, Elsa, and Sophia
Coming up with a good story is actually the part that takes the longest, at least for many of us. Some prefer a very personal story; others want to tell something less personal. That completely depends on you. Take your time, and if you can’t think of any good family story, tradition or object, just ask your family and go through the old photo albums. The story doesn’t have to be full of action, however it should have some kind of twist in it. Always remember, students of completely different countries get to listen to your stories. They surely will be interested in what is important for you.

Choosing the best story
Now you should have two or three possible stories. Which one are you going to use? Think about each of the stories and answer the questions below. Use a separate sheet for each of the possible stories. After answering these questions, decide which story is most interesting and share it with your teacher.
1. What do you think the story means? What is it really about?
2. What is the most important moment in the story? What is this moment about? Did anything change? Did you learn or realize anything new? Try to describe the moment in more detail.
3. What emotions are connected to this story? 
Writing your story script
Now it’s time to write your story down. Imagine you are telling the story to a friend. Use a fairly informal style that sounds like oral storytelling. Use simple, short sentences. Your story should not be longer than 1 A4 page – otherwise it will exceed the time-limit of our digital stories.
Keep your audience engaged. How are you going to grab their attention? It is a good idea to start with a great opening line. Something dramatic, funny, interesting or emotionally attention-grabbing.
Helpful tips:
· We recommend a spoken story length of between one and three minutes. 
· Remember stories have a beginning, a middle and an end. But a really good story does not necessarily follow a chronological order. You might start in the middle and throw your audience in at the deep end and then unfold the story from there. Try this. Find a crucial moment in your story and try to start from there in your second draft.
· Relating your story to one or more themes can help you choose what story details should go in your story and what you can leave out.
· Re-read your first draft and show it to a friend. Have you managed to get your emotions across? Are you focusing on the right things? Is anything unclear or confusing?
· Ask a friend or family member to listen or read your script. They might spot errors that you might not have seen. (Even professional script writers and journalists need proof readers, so don’t worry!)
Selecting images
[image: C:\Users\jama\AppData\Local\Microsoft\Windows\INetCache\Content.Word\avatar-2191932_640.png]The whole point of this project was that everybody tells a personal story of his or her family or about an object. So surely it is always the best to have personal photos, because while watching the video you can relate better to the story if you see the original photographs. If you have photos of your family in the video, it’s better to ask your family first whether they agree that you use photos of them. Always ask for permission to use the photos of others! If you only have one picture that is fine too, since you can then describe all the details you find on the picture. Finding photographs from the past can be great fun too. If you want to scan hard copies of photographs if they aren’t digital, just ask your teacher (see a later chapter). You could also take new photographs of objects, places or buildings that are a part of your story to build a more visual experience. Another option is to make a sketch or draw a picture.Tip from Mary
Pictures are a big and important part of your digital stories. They make your stories look more realistic and also more entertaining. You should definitely think about what pictures to take. The most important part is that you stir up emotions and really drag the viewer into the story. If possible, use pictures you took yourself so the viewer sees what you have achieved, been through or whatever your story is about. If you don’t have any pictures appropriate to your topic take some now.
Otherwise, take pictures off the internet but avoid breaching copyright. Pixabay (https://pixabay.com) is a very good website if you don’t want any copyright issues so definitely check it out if you don’t have any possible chance of taking your own pictures.

What you can’t do:
Unfortunately there are limits as to which images you can use from the Internet. This is because of copyright issues. Imagine someone using your own personal photo in an advertisement and you didn’t get any money for this. Wouldn’t you be annoyed because you didn’t give permission? This kind of situation gets more complicated (and sometimes very serious) when it is used for a public document, such as your MYSTY story. There are also restrictions such as logo’s and brand names too, but the just ask for advice from your teacher if you are unsure.
Producing your story
In order to produce a convincing story, you’ll need to structure your presentation. Your story will consist of the following elements:
· one or more pictures (if you are using a single picture you can pan and zoom in on various details during your narration)
· your voice-over
· possibly some music that enhances the meaning and emotions of the story
Storyboarding: Use an A3 sheet and draw a storyboard like the following example or do this on the computer. Paste in your text and decide what images and effects you are going to use. Photocopy your images so you can move them around in the storyboard. If you feel that some background music might enhance your story, choose a fitting piece. Images and music must be royalty-free!
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Recording and editing your story
It is now time to produce your story. You can use a variety of applications to record your voice and then put together your voice-over, pictures, and anything else you might need into a digital story video clip. Our advice is: Keep it simple! Try out a simple recording set-up and simple editing software, maybe that’s all you need to produce your story. The more features an application has, the more complicated and error-prone your production becomes. But, of course, if you know what you’re doing, go for it!
Tips for recording your voice-over: When recording your script, choose a quiet place where you or the person who is telling the story can relax. The microphone should not be too close and not too far away. While recording, speak slowly, don’t hurry. You can record your voice-over on a mobile phone; its microphone should be good enough for this task. If the school has good microphones, you can also use those for recording. Most importantly, you listen to your recording and check for volume level (too high, too low), background noises and other interferences.
Your recording does not have to be perfect, just make sure the story and the emotions get across! If you make a mistake, don’t worry. Stop where you are and re-read that paragraph. We can edit the audio later and cut out any mistakes.
You may wish to make some changes, which is absolutely fine. Discuss this with your teacher in advance so they are fully prepared before the recording! Tip from Moritz
All in all I would recommend you to use another program which is simpler to use, like Knovio, which may not be as professional, but works. If you’ve got an Apple computer or laptop I would recommend using iMovie, which is very professional but simple to use, and it neither crashes nor deletes your files.

[image: C:\Users\jama\AppData\Local\Microsoft\Windows\INetCache\Content.Word\avatar-2191918_640.png]Tips for creating your digital story: There are many applications that you can use to put together your digital story. Knovio (https://www.knovio.com/) and Office Mix (https://mix.office.com/en-us/Home) allow you to upload a presentation file and record audio directly for each slide. You can re-record the audio for individual slides too. Audacity (http://www.audacityteam.org/) is a free and easy to use piece of software for recording and editing your voice-over. Macs have a good video editing application called iMovie. Finding free and easy to use video editing software for Windows computers is a bit trickier. It is best to stick to simple and easy to use solutions such as Knovio and Office Mix. If more advanced video editing software for Windows is needed to tell the story properly, one suitable application might be Windows Movie Maker—but it is not being updated anymore. Shotcut (https://www.shotcut.org/) is another free video editing software, but some students had mixed feelings about using it in the past.
Publishing your story
Before publishing your story, have a look at it and make sure everything is the way it is supposed to be.
You need to export the story in a video format (MP4, MOV, WMV, MKV, …). This is NOT the same thing as the video project file. Or you share the video online (privately) and you have a link to the video. Then show it to the teacher, friends, family members and others and ask for feedback. At this point you can still make changes to your story, but once it is fully published and out in the open, making changes will be a bit harder to do! Before publishing, make sure that you have all the permissions to use pictures, music, sound effects, etc. – preferably in written form!
And that’s it! Congratulations!
[image: C:\Users\jama\AppData\Local\Microsoft\Windows\INetCache\Content.Word\confetti-1925260_1280.jpg]
[bookmark: evaluation]You have worked really hard on your story!
You can be proud of your work! 


Evaluation of My Story
It is now time for you to reflect on the project so far and evaluate your experiences and let us know how you came up with your ideas.  Answer the questions below with full sentences and include as much detail as you can.
1. How did you to decide on what story to write? What helped you decide?

3. If you had to give advice to other students working on a digital story project, what would you advise them about choosing a story?
2. What have you found challenging or difficult about the project so far?



Tech Guides
In this section you can find several guides which may help you with producing your MYSTY story.
List of Free Software
There are many tools available online for free which can help you produce your digital story. All tools listed below are free to use.
All-in-one solutions for the PC (recording, editing, publishing):
· Knovio – https://www.knovio.com/ 
· Office Mix for Microsoft PowerPoint – https://mix.office.com/en-us/Home
Recording your voice
· On the PC, you may use your operating systems’ built-in recording application, e.g. voice recorder in Windows or external recording software like Audacity.
· You can also use your mobile phone to record your voice. In this case, you can just download one of the many voice recording apps from the App Store or Play Store or use a pre-installed app (e.g. Voice Memos for iOS). For Android phones, you could use Audio Recorder https://play.google.com/store/apps/details?id=com.sonymobile.androidapp.audiorecorder 
Editing your audio/video
· iMovie (Mac; video editor) – https://itunes.apple.com/us/app/imovie/id408981434
· Shotcut (multiple platforms; video editor)– https://www.shotcut.org/download/
· Audacity (multiple platforms; audio editor) – http://www.audacityteam.org/download/
· Windows Movie Maker (Windows; video editor) – https://www.winmoviemaker.com/
Publishing platforms
· YouTube – https://www.youtube.com/
· Vimeo – https://vimeo.com/


All-in-one solution: Knovio (free)
Summary: This web-application is free and easy to use. In general, there should be no need for a technical advisor overseeing the production and troubleshooting processes. The web-application is mostly straight-forward to use. You must upload your presentation slides and then record your voice-over for each slide. The software allows you to re-record your voice-over for single slides if you wish to make changes. You can share your video by sending out the link.
Before you can produce your video in Knovio, you must select the pictures you want to use in your digital story. Once you have decided on the pictures, you can proceed with the instructions below. We recommend, however, that you create a presentation (e.g. in PowerPoint or PDF format) and place the pictures in the right sequence, one per slide.
To produce and share your MYSTY video using Knovio, follow the instructions below.
1. Open https://www.knovio.com/ in your browser.
2. Sign up with a free account.
3. Click on the “+New” button.
4. Upload your pictures or presentation by clicking the ‘Upload Files’ button or by drag-and-dropping files over the browser window.
5. Wait for the upload of the file(s) to finish. Then click on the ‘Record’ button and follow the on-screen instructions.
a. Knovio requires Adobe Flash Player and a plugged in Microphone to record your voice. This usually causes no problems on private computers, but Flash may be disabled on school computers. If you encounter difficulties setting up the microphone in Knovio, please contact your schools’ IT administrator(s).
6. After setting up your microphone, you should be greeted with the recording screen.
a. On the left-hand side, you can see the individual slides of your presentation.
b. On the right-hand side, you can see the green ‘Record Slide’ button. Use this button to record your voice-over – either all at once or one slide after another. You can re-record individual slides if you wish to make changes.
c. Ensure that your web camera is turned off.
d. You can view a preview of your current recording by clicking on ‘Preview’
7. When done recording, click the ‘Save’ button. Add a name and a short description, then click on ‘Save’.
8. After your Knovio has been saved, you can click on ‘Share’ to generate a link to your video. On the Share page…
a. …you can send out the link to your MYSTY story via e-mail
b. …you can also enter email addresses directly to receive your MYSTY story
9. If you want to manage your existing Knovios, click on ‘Manage’ in the top bar to open the slide library of your account. From here, you can, for example, edit, share, or archive your videos.
10. That’s all you need to know to produce and share your own MYSTY digital story!


Audio Recording and Editing: Audacity (free)
Summary: Audacity is an application built for recording and editing audio.
This application is free and relatively easy to use after first receiving some instructions. In general, it is recommended that a technical advisor is present to oversee the production processes in class and for troubleshooting purposes. 
1. Download and install the free software Audacity (http://www.audacityteam.org/)
a. If Audacity is to be set up on school computers, contact your IT administrators.
b. If it is installed on (e.g. the students’) private computers, users should be able to start up the application right after installation.
2. You may want to have a look at online tutorials. This way, you can solve smaller problems by yourself and you will be less dependent on a technical advisor being around or free.
a. Audacity tutorials can be found at https://manual.audacityteam.org/
3. Recording your voice-over in Audacity is straight-forward. Plug in your microphone and test if you can record audio by clicking on the button with the red dot.
[image: ]
a. If no audio is picked up, you may have to select the correct microphone from the microphone drop down menu and then try recording again:
[image: ]
You can also check if your operating system detected your microphone. In Windows, press the Windows button [image: ] and type ‘Sound’. In the sound application, switch to the tab ‘Recording’ and check if your microphone is displayed and picks up sound:
[image: ]
You may need to install drivers for your operating system to detect your microphone. If the problem still persists, ask your IT administrator for help.
b. If your microphone picks up your voice, you may at any time press the yellow square button [image: ] to end the recording. While recording, your recorded voice should be displayed as a wave form:
[image: ]
c. On the left-hand side of that wave form you can see a small panel. You can use the slider that goes from – to + to increase or decrease the volume (gain) of your recording. Careful: the more you increase the gain, the more unwanted noises will be picked up as well.
[image: ]
d. You can cut out parts of your recording (e.g. bloopers or stretches of empty recordings). Just select the range you want to remove and press the BACKSPACE or DELETE button.
[image: ]
[image: ]
e. That’s all you need to know for the recording! When you are done with the recording, click on File > Export Audio… Choose a name for your recording (e.g. YourName MYSTY story) and export your recording in the WAV file type.
f. Listen to your exported WAV file and check it is the way you want it to be.
g. You can now move on to editing your video (e.g. in Shotcut or Adobe Premiere Pro).



Video Editing: Shotcut (free)
Summary: Shotcut is a video editor.
This application is free and relatively easy to use after first receiving some instructions. In general, it is recommended that a technical advisor is present to oversee the production processes in class and for troubleshooting purposes.
We will use this application to create our final MYSTY story video clip. This clip can be exported locally and also shared online (e.g. on YouTube).
1. Download and install the free software Shotcut (https://shotcut.org/)
a. If Shotcut is to be set up on school computers, contact your IT administrators.
b. If it is installed on (e.g. the students’) private computers, users should be able to start up the application right after installation.
2. You may want to have a look at online tutorials. This way, you can solve smaller problems by yourself and you will be less dependent on a technical advisor being around or free. Shotcut tutorials can be found at https://shotcut.org/
3. Open Shotcut. Then follow the steps below to produce your MYSTY video.
a. Click on File > Save As… and save your (currently still) empty project. Important: Make sure to regularly save your editing progress, e.g. every few minutes. If the program crashes you might lose any unsaved progress you have made. It is recommended to save any project files in the same folder on a USB stick.
b. Click on the ‘Playlist’ button [image: ] in the toolbar to make the playlist appear. Then drag and drop all pictures, your audio recording and other files like royalty-free music onto the playlist. When finished, Shotcut should look similar to this (note the items in the playlist on the left):
[image: ]
c. Now you are ready to create and edit your digital story. First, create a video track and audio track on the timeline at the bottom of the application. To do this, click on the ‘additional actions’ menu [image: ] on the timeline and select ‘Add video track’ and then open the menu again and select ‘Add audio track’ as well. If you want to play back royalty-free music as well, you can create a second audio track. You can delete extra tracks by right clicking the time line and selecting ‘Remove track’.
[image: ]
d. You can make the timeline bigger by dragging the [image: ] symbol centered above the timeline.

e. Now drag and drop your voice-over (WAV file) onto the audio track and your pictures onto the video track:
[image: ]
If you have royalty-free music you want to include, drag and drop the music onto the second audio track.
f. To play back your current video, you can press SPACEBAR or click on the [image: ] icon.
g. [image: ][image: ]You can drag and drop the pictures around on the timeline to change the order in which they appear on screen. You can select the left and right edges of the pictures on the timeline to make them appear on screen for a longer or shorter period of time. When you move your mouse over the picture’s left or right edge, it will be highlighted in green or red.
h. Press CTRL+Z on the keyboard or select Edit > Undo in the menu bar to undo your last action.
i. You can apply a fade effect to the transition of one picture to another. First, make sure the two pictures ‘touch’ each other on the timeline. Then drag one picture into the other picture, creating an X-shape as a result.
[image: ]
j. That is all you need to know to create your video! When you are done editing, select File > Export Video, choose ‘YouTube’ from the list of presets and click the ‘Export Video’ button. The Jobs bar on the right-hand side of the application will show you when the video export is finished.
k. Watch the exported video and check if everything is the way it should be. If not, you can make the necessary changes and export the new version of the video again.


Video Editing:
Adobe Premiere Pro (subscription required)
Summary: Adobe Premiere Pro is a video editor.
This application is built for professionals who have experience in editing video. It requires a monthly subscription fee. It is recommended to have at least one technical advisor present for instructions and troubleshooting while the students are producing their MYSTY stories with the help of Adobe Premiere Pro.
We will use this application to create our final MYSTY story video clip. This clip can be exported locally and also shared online (e.g. on YouTube).
Once audio files are ready on the computer, you can start to use the Adobe Premiere editing software to complete your story. You will be given a demonstration on how to import and edit audio files and how to incorporate images into your video. Your teacher may provide an example to show you so you can familiarise yourself with the software. 
Worksheets are available if you need extra help, but there will be technicians on hand to assist!
[image: ../Disclaimer%20erasmus+.png][image: Mysty]
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Worksheet 1: Editing Audio Instructions
1. Open Adobe Premiere 

2. Select to open existing project. They are saved in Pigeonholes P Drive, MYSTY, Premiere Project Folder, then choose your group leader’s name.

3. When opening the project you will see there has been 3 ‘bins’ set up. One named ‘Audio’ and one named ‘Photos’ and one named ‘Sequence’. Your ‘Audio Bin’ will contain the voice recording and the ‘Photos Bin’ is empty.

[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0248.jpg] 

4. Double click on the ‘Audio Bin’. Then drag and drop the audio file into the timeline. 
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0254.jpg]

5. Expand the audio in the timeline so you can see the sound wave form. Put your cursor on line next to A1 on timeline and a small up and down arrow should appear. Use this pull the audio down to see the sound waves.
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0258.jpg]

6. The group leader to put on the headphones. Firstly, they need to listen to the audio file all the way through. Press the space bar on the keyboard to start and stop the audio.




7. The first section of audio to be cut out will be where the group leader has said their name. Listen again to the audio and press the space bar to pause the audio. You can see where you need to edit the name. 
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0261.jpg]
The line is the point in the audio where the reader has said their name, but before they have started reading their story.









8. Make sure the ‘Snap’ tool is selected. Then select the ‘razor’ tool from the timeline tool bar. 
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0261.jpg]
Razor tool, it looks like a razor blade.
Snap tool looks like a magnet, should be coloured blue if switched on.

9. Use the ‘Razor’ tool by clicking to select the section from the audio you want to get rid of. Don’t use the razor really close to the start of the story audio, leave a gap!
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0263.jpg]Audio should start with a short pause then the story being read.
Name to be edited out







The ‘Razor’ cutting with a gap before the story is read out. Do not cut any closer to the audio starting as it will affect the start of the story.




10. Click on the ‘Selection’ tool (shaped like an arrow) and click the section of audio you want to get rid of.
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0264.jpg]Click here with Selection Tool and the first part of the audio will be cut.
Selection Tool











Have a look at this video if you’re having problems with thishttps://www.youtube.com/watch?v=bqFrZ5CdYWI

11. The group leader is to listen to the rest of the audio and repeat step 8-10 on this sheet, using the ‘Razor’ tool to cut out any other unwanted audio.

12. At this point save the project. File, Save.

13. Where you have taken out section of audio you will see that there are gaps along the timeline, like in the photo below.

[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0266.jpg]

14. All gaps need to be closed. To close a gap where audio has been deleted click, to highlight the gap. Press ‘Backspace’ on the keyboard. The audio should snap back and the gap should disappear. Repeat this step until all gaps have gone.
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0267.jpg]
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0268.jpg]

15. Save the project. File, Save.



16. Where you have used the ‘Razor’ tool to cut audio you need to apply a ‘Default Transition’ this smooths out the audio where cuts have been made. Right click on the timeline where a cut has been made and select ‘Apply Default Transition’
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0270.jpg]
It will look like this.
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0271.jpg]

17. Apply a ‘Default Transition’ to every cut in your audio.

18. Save the project. File, Save.

19. You are now ready to import images.



Worksheet 2: Saving in ‘Sequences’ Bin
1. Adobe Premiere will automatically create a new file containing the audio editing you have made in the timeline. This is called a Sequence. You will see in the Project Window there’s a bin called ‘Sequences’ and it contains an item called ‘Audio Edit’. ‘Audio Edit’ contains the audio you have edited.

2. Right click on ‘Audio Edit’ and select ‘Duplicate’

[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0273.jpg]

3. Right click on the duplicate ‘Audio Edit’ and rename ‘Photo Edit’. You will have two files in your ‘Sequence’ bin.
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0274.jpg]

4. Save the project. File, Save.



Worksheet 3: Importing and Editing Photographs

1. Go to the ‘Project Window’ and double click on ‘Photos’ Bin. Right click ‘Import’. Go to Pigeonholes (P Drive), MYSTY, Year 8/9 and find the name of the group leader. Hold ‘ctrl’ down on your keyboard and click each image once to select. Once selected all images you can click ‘Open’.

2. The images should now be loaded into Premiere. Check they are all in the ‘Photos’ Bin. If any image files have not gone into the bin, drag and drop them in. 

[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0249.jpg]

3. Save the project. File, Save

4. The group leader must now identify using their Storyboard, the first image that is to be added to the timeline. JUST ADD ONE IMAGE AT A TIME TO THE TIMELINE.

5. Drag and drop in the first image to the timeline. This should be in the V1 section of the timeline.
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0275.jpg]


Image has been dragged and dropped into V1






6. The group leader is to listen to the audio and watch the screen to see at what point in the audio the photo should be shown. When this has been identified, click on the photo in the timeline and drag out the right end to increase or decrease the time the photo is shown for.
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0276.jpg]
Click and drag this end of the image.








7. This stage is optional. To change the size or position of the image as it appears in the preview. Click on the photo in the timeline. The go to ‘Effect Controls’ and change the values and this will adjust the photo.
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0276.jpg]

Effect Controls






[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0277.jpg]

Use ‘Scale’ and change the values, ‘up’ to enlarge the photo size and ‘down’ to decrease size





8. Save the project. File, Save.

9. Repeat steps 4-8 until all images have been used. You need to make sure you have an image showing for the full duration of the audio.

10. Save the project. File, Save.
Teacher resources
[bookmark: awards]MYSTY Project Poster for Premiere Night Celebration
To celebrate the digital stories that have been created for the MYSTY project, the school is planning on having a premiere and awards ceremony, just like the Oscars! There will various awards over the evening including one for the poster design.

1. Your task is to design a poster to advertise the event.  You need to give the poster a feeling of glamour. You must include a title for the evening, the MYSTY logo you can get this from www.mysty.eu 

2. The poster should be created in Word and set out on an A3 size page layout. To do this you will need to go to Page layout, Size, A3. If you are familiar with Adobe Photoshop or Illustrator, you may wish to use this!


3. Use a mix of images and text to advertise the event. As of yet there is no date so over look this for now. The idea is to have it in the Drama Studio. 

4. Name the poster MYSTY Awards evening and save in Pigeonholes P DRIVE, MYSTY, Year 8 and find your name.













[bookmark: recordingtip]Teachers Tips for recording:
1. Find a really quiet place with no distractions (i.e the playground)
2. Praise the pupil and congratulate them for being shortlisted. Inform them on some of the moments that really stick out to encourage them and boost their confidence for the recording. 
3. The microphone will pick up rustling, it should be attached to their shirt and about 5-10 cm away. Do a test and ask them to say their name and check the audio is correct. 
4. We encouraged pupils to break their stories into short paragraphs/ chunks and asked them to pause at these moments. 


[bookmark: editingtip]Tips for Editing:
· Have ICT technical assistance during these lessons. Even when instructions are explained, pupils will sometimes forget or have difficulty in using the unfamiliar software as it looks advanced.  
· Some pupils experienced audio problems. This may well be the schools computers but if headphones were unplugged during the editing processes, pupils had to close the programme and restart it. Ensure headphones are plugged in before you open Adobe Premiere and make sure they stay plugged in. 

 










Sharing your Video on YouTube (free)
Summary: YouTube is a free online video distribution platform that you can use to upload and share your MYSTY story. The process of uploading and sharing a video is simple and generally should not require a technical advisor to be present.
1. You can watch the official YouTube video tutorial on how to upload videos here: https://www.youtube.com/watch?v=klVWGHtRTuE
2. Go to https://www.youtube.com/ and log in with your Google account. If you do not have a Google account, you have to create a new one by clicking on Sign In > More options > Create account.
3. Click the Upload button [image: ]
4. Drag and drop your exported video (e.g. the file with an MP4 or MOV file extension; be careful not to try to upload your project file as this will not work)
a. You can choose between different privacy settings. The ‘Public’ setting will allow your video to be found via search engines, ‘Unlisted’ means your video can be accessed online via the link you share but cannot be found via search engines, ‘Private’ means nobody but you can access the video.
b. You can always change the privacy setting of your video to ‘Unlisted’ if you don’t want your video to be found via search or on your channel. To ‘unlist’ a video, go to the Video Manager, edit your video of choice, then in the section ‘Info & Settings’, select ‘Unlisted’ from the drop down menu.
5. You can add some basic infos (like title, description, tags) to the video while it is uploading. When everything is ready, click the blue ‘Publish’ button.
6. To share a video, visit the YouTube page of your video and click on ‘Share’. You will receive a link that you can then send to your family, friends, teacher and others.
7. Congratulations! You have published your digital story!


[bookmark: scan]Scanning Images
1.  Go to the printer and place your photograph on the photocopy area of the printer. Put the lid down on the scanner.
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0224.jpg]

2. Sign into the printer with your finger print. Press ‘Scan’
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0225.jpg]















3. Select ‘Scan to Folder’.
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0226.jpg][image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0227.jpg]




















4. Make sure the settings are set to colour. Go to ‘Settings’ if you need to change this. Press ‘Start’ to begin scanning.
5. The printer will then display this screen 
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0228.jpg]

6. Once finished scanning this screen will appear. Press ‘Send’
[image: C:\Users\MartCat\AppData\Local\Microsoft\Windows\INetCache\Content.Word\IMG_0229.jpg]


7. Remove your photograph from the scanner and return to your computer.

8. Go to My Computer, Library Drive (L), Subjects, Scans. You should see your scan in this folder. It will be saved as a file with your name eg. scan_c.fraser_2017_09_27

9. Right click on the file and select Copy. 

10. Go to My Computer, P Drive Pigeonholes, MYSTY, Year8/9, find your name and paste into your folder






38
37
image3.emf
“ 

 


image4.png




image5.png




image6.png




image7.png&ehk=W3ubNlRb2hD9HDWCF4t0tA&r=0&pid=OfficeInsert




image8.png




image9.png




image10.png




image11.png




image12.jpeg




image13.tmp




image14.png
/T
fimm e
o et





image15.tmp




image16.png
9 Sound

Playback Recordng  Sounds | Commurications

Select a recording device below to modify its settings:

Line
Elgato Sound Capture
Ready

Microphone
Realtek High Definition Audio
Not plugged in

LineIn
Realtek High Definition Audio
Not plugged in

Microphone
USB Audio Device
Default Device

Configure

Set Detautt [

3 Cancel

foply





image17.tmp




image18.tmp
| %] Audio Track ¥'| 1.0

e

L

Stereo, 441004z
32-bit foat

1c

a0 |

R

05

00

05





image19.png
[x] Audio Track ¥ [
Streo, a0z
22 ¢ foat

[wute | so0 |

<
Gain: +11.0 dB





image20.tmp
[ X[ Audio Track w'] 1.0

e

v

Q

1|3
i

Stereo, 441004z
32-bit foat

05

sao |
o | 00

% |05





image21.tmp
[x Audio Track ¥ [ 1.0
Steeo, 441008z
2. foat

| wute | soo |
= | 0o

05

L & |08
o





image22.tmp




image23.tmp
Eie Edit View Settings Help

B 2 C & i i -z Y (-]

OpenFle Save Undo Redo PeskMeter Propertes Recent Playist Hstory Fiters Tmelne Bxport
Playist
Thumbnai clip

avatar-2191918_640.png

confetti-1925260_1280jpg  00:00:00:00

Empty-frame.png 00:00:00:00 00:00:

Mhoosoa , | poasgon |

7 = [ =l 00:00:00:00

Bgort | Properties | Playist | Fiters Source | Project

/00:10:00:00 Mo

Timeline

= ¥ = A veE f)e®® 9





image24.tmp




image25.tmp
m i,

AL

¥El = vE Ne® Q4

a




image26.tmp




image27.tmp
00:00:17:19 5 /001 Ko« > »





image28.png
00:00:17:19 5 /001 Ko« > »





image28.tmp
uice my mystystory testway.
JOnlprot vy

Ik
Wi

A





image29.tmp




image30.png
Joo:00:05:08

quide my mysty story testwav

T A R e

VI g




image31.png
Joo:00:05:08 | Joo:00:10:16

quide my mys:y story test.wav

JORlyop

B A e





image32.tmp
quide my mysty story test.wav

A A





image35.jpeg
B Adobe Premiere Pro €C 2017 - E\Documents\IDEOAdobe\StEds &

File Edit Clip Sequence  Markers Graphics Window Help

Media Brov

1 0f 4 items s

FrameRate ~  Media Start Media End

00:00:00:00000  00:00:39:32(





image36.jpeg
B MGG
B M6 st
B wessar
B M6 59130
B MG6_991456
B M6_s9170p6
B MG_9918.56

25006 o0:00:00:00

0039116

00;00,00,00 ¢ el > H o

- o muw L T T T T

sh ol o osw geme cas

ovaned  Gmssa oo onauss:
T T R R

G Lo GO T G P T R ROREeE CeR e





image37.jpeg
Project: StEds test
R

> M presets
> B Lumetri Prasets
~ M judio Effects
B Fill Left with Right
B8 Fill Right with Left
> IR Audio Transitions .

fx Channel Volume
~ 8 video Effecs o
~ M Genete S
£ yedropper il Bh
> B Video Transitons

Velodty: 00/ second

« audio edit
s 00:00:00:00
£ 0 ® v

<
B .
[ [ o
r ev 8o
¥ <= -
T o os @
; & A adot
o ¢ o)
o s g
s
@ Master ki
o
theeffec.

© Oroponto adipto PPY

TR




image38.jpeg
:04:07

:00;

00.

i

fi

L m 9

=

x audio edit





image39.jpeg
EE m g

Rl
I
&

00:00:00:11

* audio edit =

oy 100:00 00:00:05:00 ko0
e AL \ ‘

2oy





image40.jpeg
m 0 e O B W W

s
i

00:00:00:11

% audio edit =

’“\. 00:00:00:11

00:00:05:00
1 ! ol





image41.jpeg
00:00:00:00 Ft - Ful
o

o |} e« p o S

w o B W w
00:00:00:00 >

00:00:25:00 00:00:30:00

R e e

° = ruioss 5 e -
e ;
w\uu-d-cu Un:,- uv- g .. - nn- i . %0 -





image42.jpeg
00:00:00:00 Ft v ~

p m a0 00:00:00:00 Sl L R B L

0:00 00:00:05:00 00:00:10:00 00:00:15:00 00:00:20:00
T e e e T e e

‘Shift, Alt, and Crl for other options.

om@amed»e®





image43.jpeg
00:00:00:00 Fit -
ool i «
°

00:00:00:00 Mo

mww-u-fgm:w:'ﬁ".' oo HHBEFS®QCHR





image44.jpeg
00:00:00:17 g

00:00:10:00 00:00:15:00 00:00:20:00 00:00:25

i for other options.

o B K@Y e @ BMNBEWY A SHOFE
4 o o e




image45.jpeg
00:00:00:17

o

A moa g

00:00:00:17 L
00:00:05:00 00:00:10:00 00:00:20:00

vll\li'l\!ll\\‘\\ | 1 Vo peae b g Gl B S

srrbilat

’fi
¥
o

b

oo




image46.jpeg
n Adobe Premiere Pro CC 2017 - E\Docum ents\VIDEO\Adobe\StEds test *
File . )

Graphics  Window Help

Edit Clip  Sequence Markers

Cut c [
Copy
Paste

Clear

Duplicate

Clear In an

Hide

View Hidden

Modify

Properties...

Sequence Settings...

in Expl
Reveal Project in Ex
Re figinal

Rename

m O New Sequence From Clip 10:00:0
i

1]

ace Footage..
» audio edit =
Link M

’ 00:00:00:17 ‘ 00:00:10:00
o n

4

>

|+ a v =2

erclip Effects

Label

1 €% I





image47.jpeg
Project: StEds test = Effects
SEds test.prproj

bl

Name Frine ot - e
ate A Media Start
B> m oo Media End

W > m photos

M - W sequences

<

‘71 & audio edit 25.00 fps 00:00:00:00 00:00:26:23
| de photo edit 25,00 fps 00:00:00:00 00:00:26:23

00:00:00:17
| W
o
8= ® O w P M 9 @
00:00:00:17
audio edit x photo edit
[ —_—
00:00:00:17 00:00:05:00 00:00:10:00 00:00:15:00 00:00:20:00
[BSReE l I i

T i e e

o0 5 oe

A

?*

la) av B o

9, 6 Vv B o

“ ﬁ-so

- oM s &

& [ALHudio 1





image48.jpeg
v | Adobe Premiere
File | Edit Clip | Se

»

9 of 13 items selected

Frame Rate Media Start Media End

EEH 2 20332 WAY 18,000 Hz

IMG_9910.JPG

IMG_9911.JPC

IMG PG

IMG_9913.1PG
MG_9914.)PG

IMG_9917.P6

FEEPPPEEREEREE

IMG_9918.JPG

~ [ sequences

00:00:00:00

o m 9 W
=0 B

n

x Timeline: (no sequences) =

r

0;00





image49.jpeg
MG_9909.0PG

B > O Rotation 0 o e
B MG_s9100p6 © Anchor Point m00 7m0 a
B MG_99119p6 > O Anti-licker Filter 000 o
B MG_9912.3pG ¥ fi Opacity a
B MG_ss1396 oos
B ™MG_99143pG - Doy - e
= Blend Mode Normal v a
B me_s17r6 > | Time Remapping
B MG_%918.pG
~ M sequences
45 audio edit 2.00fps
dc photo edit 25.00 fps 1 00:00:00:00
o
o o
oo
.o w o mwE t
audio edit »_photo edit =
00:00:04:20 00:00:15:00
X O IEN

Ao “Guplicate clip. Use Shft to pin to 3 track.

o ma®H0D

emEfimAmneaOR





image50.jpeg
Frame Rate A

Effects Workspaces
Lprproj
-]
audio
photos

B 1MG_9903.376
B IMG_3909.0PG
B IMG_99100PG
B IMG_39112PG
B IMG_3912JPG
MG_9913.3PG
B IMG_99140PG
B IMG_9917JPG
B IMG_9918.3PG

Bm sequences

e audio edit 25.00 fps

e photo edit 25.00 fps
o

audio edit x photo edit
00:00:03:24

*ﬂ"\

@ Master

o Type here 1o search

Media Start

00:00:00:00
:00 00:00:26:23

1 0f 14 1tems selected

Media End

-p-I!

00:00:26:23

~ i T Motion.

O Position
> O scale
5

> O Rotation
O Anchor Point
> O Antiflicker Fiter
~ fx Opacity
oas
> & opacity
Blend Mode
> TimeRemapping

8970 4360
3

Uniform Scale
00°

25920 1728.0
0.00

1000 %
Normal

e

00003500

~ OB 0o

&

CERE R R





image51.jpeg
= e

sk
oo
- of 14 tems selected. ¥
P
e |0 en
s | o o
B o > »
gy Busonsa
B | > © Rotation 0ne
B mosrs | ©mdmrun s
B Mo e > © okt o 5
B we e ~ team 5
B momn oos i
B o mine i Pt o o %
B wesmne | meremopes :
B mossiro | *
g ok e | oy :
i shotocan Zaw e s | ‘ 1l 2 e
| . J T e .
= miom e wl 7 ClEs
00:00:03:24 g :

x n® o

aw o
ramo
e = °
st
& (KL ot
o
o 0 pawo ©
em s
& vster oot

o

O wenereose®




image52.jpeg
s selected

Media End

00:00:26:23

~ fx L% Motion
D Position

> O Scale

>

> O Rotation
) Anchor Point
> O Anti-flicker Filter
~ fx Opadty
oods
> [ opacity
Blend Mode

> fi Time Remapping

960.0  540.0

SI.OQ*D

Uniform Scale
00°
25920 17280
0.00

100.0 %
Normal

515151515 15 SSHSE

1515





image1.jpg
)
S/ A/ A
Y A/ A/ AW N
¥ A 3
. \\ “. B ,.\‘“ '
St oty A “:

Co-funded by the
Zi o N Erasmus+ Programme
% of the European Union
\l [

L) r
P X, (~ CENTROSVILUPPO g
BB NS R UNIVERSITY OF
LY DANILO poLCl GLOUCESTERSHIRE
NS /’/\u eeeeeeeeeeeeeeeeeeeeeeeee
¥ \l

mysty gibs




image53.tmp




image54.jpeg




image55.jpeg
System Menu. Counter \

f

Status/
Job Cancel

&5 Copy Auto Color

N T g

Home

:

-

|4

6

28/09/2017 16.08

Reset
Clear
=
Quick No.
Wi ¢ Ston

@ o

ol





image56.jpeg
Log out

Account: My Personal Account Balance: unrestricted

Scan to folder

-+ Swatus  § User Catherine Fraser , ¢ fraser





image57.jpeg
System Menu Counter

Status/
Job Cancel

Scan to folder

|1 2

Home
B Copy Auto Color

3

lor PDF
od
A4 Portrait
300 DPI

[

Clear
fc

Quick No.
Search

28/09/2017 16:09

Reset

Stop

Enet





image58.jpeg
nning... page 1

® Pausing Scanner.

CEEEEE—

System Menu Counter\ = ’ 3

1 f f o Reset
: Clear

ety





image59.jpeg
& User: Catherine Fraser , c fraser

e
’System Menu Counter \
Stk;atus/ Home
Job Cancel BECony Aiitn Colar

Caneel

28/09/2017 16.09





image2.png




image33.png
Erasmus+ Programme endorsement of the contents which reflects the views only of the authors, and the Commission

- Co-funded by the The European Commission support for the production of this publication does not constitute an
of the European Union cannot be held responsible for any use which may be made of the information contained therein.




image34.jpeg
mysty




